
Illustrator 9.0
provides the control
you need to achieve
the highest quality
output.

Adobe®
 Illustrator® 9.0 sets new standards for vector graphics creation software. With flexible, versatile trans-

parency capabilities, live object and layer effects, and an overprint preview mode, it provides compelling

benefits to graphics professionals and service providers alike. Graphics created with Illustrator 9.0 will print

to existing Adobe PostScript® Level 2 and higher printers, and they can be placed in existing applications, such

as Adobe InDesign™, Adobe FrameMaker®, and QuarkXPress™.

This document gives you the information you need to produce consistent high-quality output when you print

or export the artwork for use in other applications. It details the ways specific settings will affect transparency

output—you'll see that experimenting with just a few settings can make a big difference in your results. The

document explains what you can gain from the Overprint Preview mode, and how Illustrator works with live

effects that must be rasterized. Consider this document a useful supplement to your User Guide, because it

includes information that wasn't available when that guide went to print.

At the end of this document, we've included a glossary of terms and an index to potential issues discussed in

this paper. This paper is frequently updated; visit http://www.adobe.com/products/illustrator/main.html for

the latest information.

Printing and exporting objects with transparency
With Illustrator 9.0, you can apply transparency settings to any layer, group, or object, including raster im-

ages, type, and spot colors, so that other objects can show through. Using the transparency technology, you

can change the opacity of objects against other objects or against a background, apply blending modes to

your artwork to create special color effects, or create opacity masks or knockouts in the artwork. To print or

export artwork with transparency effects, Illustrator flattens transparent objects into component objects

based on the settings you choose in the Document Setup dialog box. Whether components remain vectors or

are rasterized is primarily determined by the setting you choose on the Quality/Speed slider in the Document

Setup dialog box. A higher percentage of vector components results in longer, more memory-intensive pro-

cessing, but usually produces higher quality printed results. The slider position affects the way Illustrator

flattens different kinds of objects (e.g., text, strokes, and embedded images).

Overview of flattening
Before printing or exporting artwork that contains objects with transparency effects, Illustrator 9.0 flattens

overlapping transparent objects. That is, Illustrator divides transparent artwork into its individual compo-
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Illustrator 9.0 flattens artwork that
contains transparency before
exporting it into a non-native format.
However, if you save the artwork
in a native format (that is, as an
Illustrator 9 file or a PDF 1.4 file),
Illustrator does not flatten the
artwork. Illustrator 9 EPS files include
both flattened and native data.

Figure 1
To print or export artwork with
transparency, Illustrator flattens
the artwork so that overlapping
transparent regions are represented
by discrete components.
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nents so that overlapping transparent regions are represented by distinct pieces (Figure 1). The result is

similar to using the Pathfinder command on an object to break it down into its component pieces. Illustra-

tor provides this flattened data to PostScript and non-PostScript printers, which can then print the artwork

so that it appears transparent.

Flattening artwork creates many smaller regions, so the resulting file contains more vector data than the

original transparent document. However, the unflattened artwork remains in the Illustrator 9 EPS or AI file

so you can return to the original artwork to edit it.

Whenever possible, flattened components are represented as vector objects, filled with solid colors (as in

Figure 1) or with a gradient or gradient mesh (for example, when a gradient overlaps a transparent solid-

colored object). If Illustrator cannot represent the flattened components as vector objects, it rasterizes them.

For example, the flattened components may need to be rasterized if two gradients were blended together

(Figure 2).

Controlling whether flattened artwork is rasterized

Transparency effects will print differently if components are rasterized than if they are vectors. Though

rasterized artwork is usually faster to process, vector artwork usually results in a cleaner, higher quality

printout.  The pages that follow can help you consider when and how to change the defaults. Note that there

are some objects that Illustrator must rasterize, no matter what settings you select.

You can affect the degree to which the flattened artwork is rasterized—that is, you can adjust the percentage

of artwork that remains vector artwork to the percentage that will be rasterized—by adjusting the Quality/

Speed slider in the Transparency panel of the Document Setup dialog box (Figure 3). (Choose File > Docu-

ment Setup, and then choose Transparency from the pop-up menu.) Consider the nature of the artwork, the

resources available on your system, and the speed with which you want to process the file as you decide how

to adjust the slider.

Figure 3 on the next page shows the Quality/Speed slider and its positions. The Quality/Speed slider posi-

tions determine how Illustrator flattens artwork that contains transparency. Higher positions on the Qual-

ity/Speed slider (those closest to the Higher/Slower end) result in a higher percentage of vector components

and will generally produce higher quality printouts. However, a higher percentage of vector components

results in longer, more memory-intensive processing, and a combination of rasterized and vector compo-

nents may result in color stitching effects (see "Avoiding Color Stitching" on page 7). Selecting position 1 or

2 does not necessarily result in poor image quality when you print; the printing quality at these positions

depends on the artwork you're printing because the slider positions affect different kinds of objects differ-

ently.  Furthermore, even if you select position 5 all the time, Illustrator may not be able to represent all

objects as vectors. For example, if gradient-filled objects overlap and the top object is transparent, the result

cannot be reduced to a reasonably sized set of vector objects so Illustrator must rasterize the flattened ver-

sion. Your settings, therefore, wouldn’t affect this region of the graphic, though they’d still apply elsewhere.

You should experiment with the
slider positions to find the best result
for your printing environment.

Illustrator 9.0 only supports printing
to Adobe PostScript Language Level
2 and PostScript 3 devices.

Figure 2
If two gradients are
blended together,
Illustrator cannot
represent their
flattened components
as vector objects, so it
rasterizes them.
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1. Rasterize all  
Artwork

2. Maintain simple 
vector objects, 
but rasterize 
more complex 
areas involving 
transparency.

3. Maintain most 
objects as 
vector data, but 
rasterize very 
complex 
transparent 
regions.

4. Maintain most 
of the 
illustration as 
vector data, 
and rasterize 
only extremely 
complex areas.

5. Maintain vector 
data to the 
greatest extent 
possible.

Slider positions, from left to right:
Position 1 – Lower/Faster

What it does: Rasterizes all artwork. The speed with which

the artwork is processed depends upon the Rasterization

Resolution setting in the Printing & Export panel of the

Document Setup dialog box. At low resolutions, rasterized

artwork will be processed quickly; at high resolutions, it will

be processed slowly.

When to use it: To print or export very complex artwork

with many transparent objects. Use it with a low resolution

to proof complex illustrations that include many transparent

regions; for higher quality results, print at higher resolutions.

Note: At higher resolutions, the size of saved files or print

spool files may be large. For more information about setting

resolution values, see “Setting transparency resolution when

rasterization is necessary" on page 4.

Position 2 – between Lower/Faster and the mid-point

What it does: Maintains simple vector objects, but rasterizes

more complex areas involving transparency.

When to use it: To print artwork containing only a few trans-

parent objects, or when you are working on a system with

low memory.

Note: Some printing devices may produce color stitching—

rough transitions between bordering vector and raster ob-

jects—and make hairlines (lines that are a device pixel wide)

appear thicker. For more information on color stitching, see

“Avoiding color stitching" on page 7.

Position 3 – midpoint between Lower/Faster and Higher/Slower

What it does: Maintains most objects as vector data, but rasterizes

very complex transparent regions.

When to use it: To achieve a balance between the speed of the

flattening process and the number of regions that are rasterized.

Note: This is the default position. For some printers, this position

reduces color stitching and hairline weight issues.

Position 4 – between Higher/Slower and the midpoint

What it does: Maintains most of the illustration as vector data,

and rasterizes only extremely complex areas. To minimize any

color stitching artifacts, such rasterized areas are clipped along

objects' paths (unless the resulting clip would be too complex).

When to use it: To achieve a higher quality scalable output.

Note: The processing time required increases with each transpar-

ent region in the artwork. This position reduces stitching and

hairline weight issues for some printing devices.

Position 5 – Higher/Slower

What it does: Maintains vector data to the greatest extent

possible.

When to use it: To achieve the highest quality resolution-

independent output and least image degradation.

Note: This setting is extremely time- and memory-intensive for

processing complex illustrations.

Figure 3
The Quality/Speed slider in the
Document Setup dialog box plays a
critical role in determining the way
Illustrator flattens artwork; positions
in the slider are mentioned fre-
quently in the sections that follow.
To learn about the other options in
the dialog box, see chapter 8 of your
User Guide.

Overview of the Quality/Speed  slider in the
Transparency panel of the Document Setup dialog box
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Setting transparency resolution when rasterization is necessary

By default, Illustrator rasterizes flattened artwork at a resolution of 300 ppi. This provides good quality

printing for most artwork. However, you may want to lower the resolution to speed the printing on a quick

proof,  or you may want to raise the resolution to improve the print quality of some artwork, especially if it

contains text that will be flattened.

You can modify the resolution of rasterized areas in the Rasterization Resolution field in the Printing &

Export panel of the Document Setup dialog box (Figure 4). (Choose File > Document Setup and then

choose Printing & Export from the pop-up menu.) For best results, use the formula line screen * 2 to deter-

mine the output resolution in dpi for rasterized objects, but keep in mind that some transparency areas,

such as large areas with mixed gradients or gradient mesh, require only one-half to two-thirds of the con-

ventional resolution. On the other hand, type usually requires 600 ppi for optimal results.

Effect of the Quality/Speed slider positions on different objects

Illustrator uses different processes to break different types of artwork into components. The following sec-

tions describe how Illustrator will flatten the objects in an illustration based on the position of the Quality/

Speed slider, and how you can obtain the best results printing them.

Flattening strokes

To flatten a stroke, Illustrator must convert it into a filled object. Whether Illustrator flattens a stroke, and

thus converts it to a filled object, or rasterizes it, depends on the Quality/Speed slider position in the Trans-

parency panel of the Document Setup dialog box.

When the slider is at position 1, all strokes will be rasterized and image integrity depends on the value in the

Rasterization Resolution field in the Printing & Export panel of the Document Setup dialog box.

When the slider is at position 2 or 3, any stroke that overlaps a transparent object, or that has transparency

applied to it, will be converted to a filled object. Very thin strokes may change weight, causing these strokes

to appear different from identical strokes that do not interact with transparency. This effect is most apparent

on low resolution printers. Any paths that are converted will result in an increase in the number of paths in

the file.

At positions 4 and 5, all strokes will be converted to filled objects in a document that contains transparency

effects, whether or not the strokes directly interact with transparency. This prevents visual discrepancies in

stroke weights, but it does increase the number of paths in the file.

To determine what

resolution was used for

rasterization,  open the

file and look in the Print-

ing & Exporting panel of

the Document Setup

dialog box.

If you are using an AI9

EPS, you can increase

these values, resave the

file, and then print.

Figure 4
Illustrator uses the Rasterization
Resolution value in the Document
Setup dialog box when it rasterizes
flattened artwork.
For information about the other
features in the Printing & Export
panel of the Document Setup dialog
box, see your User Guide.
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Flattening text

When Illustrator flattens text with transparency effects, it preserves the text as text objects, but clips and

masks it as necessary to create the effect. However, if the text is stroked, used as a clip, or contains a pattern

fill, Illustrator will convert it to outlines and treat each character as an individual vector object. (Illustrator

will also convert text to outlines if it is in a very complex region of the artwork and the Quality/Speed slider

in the Document Setup dialog box is at position 4 or lower.)

For example, if a transparent object overlaps a text object, Illustrator clips the portion of text that interacts

with the transparent region. By comparison, if text overlaps a transparent object filled with a hatch pattern,

Illustrator converts the text to outlines and treats it as vector objects, rather than clipping the text to each of

the hatch paths and creating a very large number of clipped text regions.

If Illustrator is unable to convert such text to outlines because the outline information is not available (e.g.,

it’s a bitmap font; a “partial” bitmap font; or a protected, outline-restricted font), Illustrator rasterizes the

text that intersects with transparent objects.

If strokes are converted to fills when Illustrator converts text to outlines, the fills will be wider than the origi-

nal text by 1 or 2 device pixels. This conversion may make text appear thicker on low-resolution output

devices, such as inkjet printers. To prevent the thicker strokes, do one of the following:

•Adjust the Quality/Speed slider to the right. When the slider is at position 5, for example, text won’t

appear thicker.

•Move the Quality/Speed slider to position 1 so that all the artwork, including the text, will be rasterized.

•Specify a higher value in the Rasterization Resolution field in the Printing & Export panel of the Docu-

ment Setup dialog box—600ppi or greater should give good results.

When you save a document that contains transparency as an Illustrator 9 EPS file, a native Illustrator 9 file,

or a PDF 1.4 file (Adobe Acrobat® 5.0 format), the text remains text objects. However, If you save artwork

that contains transparency (including opacity, masks, or blend modes) to EPS 8.0, PDF 1.3 (Acrobat 4.0x),

or AI 8.0 or earlier  format, all the text will be converted to outlines or rasterized. To preserve the text

editability , you can save the file as an AI 9.0 EPS file and then use Acrobat Distiller to convert it to PDF 1.3

(Acrobat 4.0x) format. Alternatively, you can flatten the objects that are affected by transparency (assuming

text is not affected by transparency) before saving the file in PDF 1.3 (Acrobat 4.0x) format or Illustrator 8.0

or earlier format.

Flattening complex artwork

Maintaining vector data when flattening an area that contains thousands of paths and intersections—as

would happen if a transparent object overlaps an object filled with a hatch pattern—requires creating thou-

sands of individual component pieces, some only the size of a single pixel. When the Quality/Speed slider is

at position 5, Illustrator will maintain the vector data, but when it is at any other position, Illustrator will

rasterize such a dense area.

160 paths 1312 paths 3212 paths

Converting artwork that includes
transparency effects from the
Illustrator 8.0 plug-in
Transparency effects you created in
Illustrator 8.0x using Hot Door's
Transparency plug-in are retained
when you open an Illustrator 8.0
document in Illustrator 9.0.
However, if you plan to create new
transparent objects in Illustrator 9.0,
remove the transparency that you
created with the plug-in and then
reapply transparency using the
Illustrator 9.0 Transparency palette.
To remove transparency that was
created with the plug-in,click Release
in the Transparency palette. (The
Release button will only appear if
Hot Door's Transparency plug-in
is installed.)

Figure 5
Here, a rectangle containing a transparent
pattern is rotated and duplicated, resulting
in a large number of discrete regions in the
flattened artwork. When the Quality/Speed
slider is at position 5, Illustrator may be able
to maintain the vector data; at all other
positions, Illustrator will rasterize the
artwork.
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Flattening gradient mesh objects

Illustrator uses the Smooth Shade operator in PostScript 3 to create gradient mesh objects, so it prints them

to PostScript 3 printers as native vector objects. If it cannot represent a gradient mesh object with overlaid

transparency effects as native vector objects, it will rasterize the gradient mesh object. To PostScript Level 2

printers or to an EPS with PostScript Level 2 compatibility, Illustrator includes gradient mesh data as both a

native vector object and as a rasterized object that is converted to a JPEG. In Illustrator 8.0, the JPEG has a

resolution of 150 ppi, but in Illustrator 9.0, you can specify a resolution in the Mesh field in the Printing &

Export dialog box. (Choose File > Document Setup > Printing & Export.)

Flattening placed or embedded bitmap images

As with other objects, Illustrator flattens embedded bitmap images differently depending on the position of

the Quality/Speed slider in the Document Setup dialog box. When the slider is at position 2, Illustrator will

rasterize the portions of the bitmap image that overlap an object with transparency. This area will be re-

drawn at the resolution set in the Rasterization Resolution field in the Printing & Export panel of the Docu-

ment Setup dialog box. If the resolution set in that field is lower than the original resolution of the image,

you may see color stitching where the regions join.

If the slider is at position 3, 4, or 5, Illustrator rasterizes the entire image at the resolution set in the

Rasterization Resolution field, preventing stitching effects. Note that the image will be redrawn at a lower

resolution if the resolution specified in the Rasterization Resolution field is lower than the original image

resolution.

Flattening placed or linked EPS files

If an EPS graphic is involved in a transparency effect, embed the graphic into the document using the Em-

bed Image command in the Links palette. (See Figure 6.) If you do not embed the EPS graphic, Illustrator

will display a warning when you place the graphic into a document that contains transparency effects and

when you print the document. If you print the document without embedding the EPS graphic, the EPS

graphic will print first, under the other objects on the page, usually resulting in incorrect output.

As in Illustrator 8, DCS, duotone, tritone, and quadtone files are only compatible in a linked workflow

within Illustrator. If you embed these images, they will be converted to grayscale images. Therefore, these

images are generally not compatible with transparency.

Printing spot colors in artwork that includes transparency

Improvements in Illustrator’s overprint preview and color management technology result in composite

printout color values that more closely match the spot colors printed on press. However, the color values are

more accurate only if there is transparency or overprinting in the document; if there is no transparency or

overprinting in the document, spot colors will print as they do from earlier versions of Illustrator. (Note that

you can indirectly include transparency in the document through using a style or a brush that includes

transparency, using a blending mode, or setting an object to overprint.)

Figure 6
If a linked EPS file interacts with transparency. . . Illustrator displays a warning when you print the artwork.

If you print the document without embedding the EPS graphic, the
document may not print correctly.

Saving artwork in earlier formats
When you save artwork that includes
transparency in Illustrator 8-compatible
formats, Illustrator converts all spot
colors to CMYK values. If you need the
file in an earlier format, save the artwork
as an Illustrator 9 EPS file and then use
Acrobat Distiller to convert it to PDF 1.3
(Acrobat 4.0x) format.
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When you save artwork that includes transparency to PDF 1.3 (Acrobat 4.0x), Illustrator 8, or other earlier

formats, Illustrator converts all spot colors in the artwork to CMYK values to avoid color stitching in flat-

tened regions. However, spot colors are preserved when you save the artwork as an Illustrator 9 EPS file,

native Illustrator file, or PDF 1.4 (Acrobat 5) format file. If you need the file in an earlier format, you can

preserve the spot colors by saving the artwork as an Illustrator 9 EPS file and then using Acrobat Distiller to

convert it to PDF 1.3 (Acrobat 4.0x) format. (The composite view of the document may not appear accurate

on-screen in Acrobat 4.0x, but the document will separate correctly.)

Color management uses the working space to change the CMYK equivalents of a spot color into equivalent

values for a device-independent color, which is managed using the printer profile. If you save the artwork in

PDF 1.3 (Acrobat 4.0x) format, the document profile is used as both the source and the destination profiles.

If you don’t want the color values to change, convert the spot colors to process colors before printing or

saving as an Acrobat 4.0-compatible PDF file (PDF 1.3 format).

Blending modes

The transparency technology in Illustrator 9.0 makes it possible to blend the colors of objects with the colors

of underlying objects, using many of the same blending modes you use in Adobe Photoshop®.

The blending modes you use will determine what the resulting color will be and which color plates will

print. For example, using the Hue blending mode between a Cyan object and a Magenta object could result

in a color that can only be represented using all four separations (CMYK). To ensure accurate printing,

Illustrator will create all CMYK plates when you use Difference, Exclusion, Luminosity, Color, Hue, or Satu-

ration blending modes in a document.

Photoshop 5.5 and earlier treats Soft Light, Color Dodge, and Color Burn in a non-standard way when the

base (the object you are blending against) has less than 100% alpha.  Illustrator uses the standard blending

method even for these modes, so whenever you use them against an empty page (which is 0% opaque) or

against artwork that is less than 100% opaque, your document will look different in Photoshop. Future

versions of Photoshop will use standard blending for all modes, so artwork using these blending modes will

appear the same in Illustrator and Photoshop.

Exporting artwork with transparency effects for use in other applications
Illustrator 9.0 transparency effects are unique; the transparency technology does not yet exist in Adobe

InDesign, Adobe FrameMaker, QuarkXPress, or other released publishing applications. To use Illustrator 9.0

artwork that contains transparency effects in these applications, save the Illustrator 9.0 document as an AI9

Avoiding color stitching
Color stitching is the visible transition between rasterized images and vector

objects that are adjacent to each other. Color stitching occurs when a printer

driver processes solid colors and images differently. The likelihood of color

stitching when you print an object with transparency from Illustrator is highest

when the Quality/Speed slider in the Document Setup dialog box is at position

2 and the likelihood of stitching decreases for positions 3 and 4. It is not likely

to be visible at position 5.

If you see color stitching in your printed artwork, do one of the following:

•Disable color optimization in your printer driver, by deselecting the Vivid

Color, Intelligent Color, or similar option in the printer driver’s Properties

dialog box. (Choose Print Setup > Properties.) This removes the color stitching while maintaining the quality of your printed artwork.

•Adjust the slider to the next position (that is, from position 2 to 3, from 3 to 4, or from 4 to 5). This reduces the number of rasterized

areas in an image, reducing the chance that a rasterized area abuts a vector area.

•Move the slider to position 1. This rasterizes all areas of the illustration that contain transparency, so no vector areas abut rasterized areas.

Color stitching effects may appear on screen if you preview flattened artwork with anti-aliasing on, but such effects will not print or export.

For an accurate preview of flattened artwork, turn anti-aliasing off by choosing Edit > Preferences > General, and then deselecting Anti-

Aliasing Artwork.

When you blend
non-opaque artwork against
Illustrator’s artboard, you may see
some color shifting on screen. This
will not affect printing.
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EPS file and then place or link it into the application. The EPS file will print with the expected transparency

effects because Illustrator flattens the transparent artwork when it saves the EPS file the same way it does

when you print directly from Illustrator. However, because the transparent objects are flattened, you cannot

place an EPS file with transparency over another object in a publishing application and expect to see the

other object through it.

When Illustrator saves the EPS file, it includes its original data in the file, so you can open the EPS file in

Illustrator and change settings, save the EPS again, and replace it in your application. Documents saved as

EPS files will separate correctly and print as composite correctly directly from Illustrator.

EPS files that include Illustrator 9.0 transparency effects may not separate correctly from other applications

if you do not print all the spot color plates. For example, if you place an illustration that contains transpar-

ency effects and four spot colors (CMYK, plus spot colors 1, 2, 3, and 4) in another application and then

convert all but one of the spot colors to CMYK, so that only one of the spot color plates will print (CMYK

and spot color 2 only), the illustration may not separate correctly. If you want to reduce the number of spot

colors that will print from an EPS file,  open the original artwork in Illustrator, convert any spot color to a

global process color, and then resave the document.

Working with live effects that require
rasterization
Powerful object and layer effects in Illustrator 9.0 let you apply

transformations, filters, distortions, and more to any object,

group, or layer as a series of “live” effects. That is, these effects

change only the appearance of the selected object, not the

selection itself, so you can edit the underlying object or any

step in a series of effects you’ve applied without having to redo

the others.

Some of these effects require rasterization (see the sidebar). By

default, Illustrator 9.0 rasterizes objects with these effects

applied at 72 ppi, so the artwork will print at a low resolution.

You can change the resolution in the Rasterize Effects Settings

dialog box. (Choose Effects > Rasterize > Rasterize Effects

Settings.) The resolution that you choose affects all objects

with rasterized effects in the document.

Specifying higher resolutions will increase processing time, so

you may find it easiest to leave the resolution at 72 ppi while

you’re working in the file and increase the resolution just

before printing or exporting the file. If you're a service pro-

vider and you receive a file with a low resolution setting, you can open the file, change the resolution in the

Rasterize Effects Settings dialog box, and resave the file before printing.  The resolution setting also influ-

ences the effect that resolution-dependent filters (such as Crystallize and Pointillize) have on objects.

Overprinting Preview
Overprinting is the application of one ink on top of another on a printing press, usually including one or

more spot color inks. You can use this technique to achieve different colors, apply translucent varnishes, or

increase the intensity of a color. You can specify that an object should overprint through the Overprint

Stroke/Fill options in the Attribute palette; overprinting may also occur when you define spot-to-process

and spot-to-spot blends.Traditionally, it has been impossible to simulate overprinting on screen or when

printing to a composite printer—only the top ink layer has been displayed or printed. Because there was no

way to accurately preview overprinting effects, overprinting could provide unpredictable results.

Illustrator 9.0 includes a new previewing mode that lets you proof your overprinting effects on-screen and

see how spot color inks will look on a press. To preview overprinting attributes on-screen, choose View >

Overprint Preview.  You can also preview the overprinting effects in a composite printout. Note that the

Effects that require rasterization
Artistic
Blur
Brush Strokes
Distort
Pixelate
Sharpen
Sketch
Stylize
Texture
Video
Drop Shadow (if blurred)
Inner Glow
Outer Glow
Feather

Figure 7
The Resolution value you enter in the Raster
Effects Settings dialog box determines the
resolution Illustrator uses to rasterize effects.
By default, this value is 72ppi.
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accuracy of the overprinting preview depends on the colorants involved. For example, the overprinting

preview cannot predict the effect of blends involving metallic or fluorescent inks.

If you use the Separator feature in Illustrator to perform color separation, Illustrator uses a non-zero

overprinting method. Using the non-zero overprinting method, if a color component in a spot color has a

value other than 0%, it will replace the corresponding color component of the objects beneath it; if it has a

value of 0%, the corresponding color component in objects beneath it will be unchanged. You can see the

effects of the non-zero overprinting method when you check Overprint Fill or Overprint Stroke in the

Attributes palette.

Even when nothing is set to overprint in the document, the Overprint Preview mode can show you how

transparency effects will print. In this mode, overprint blending is applied to all spot colors in a document

when transparency is used anywhere in the page. Such blending prevents stitching effects and results in the

expected color separations (e.g., spot colors remain spot colors). Overprint Preview blending is only applied

on-screen, when printing to a composite PostScript or GDI device, and when saving artwork that contains

transparency to a file format that requires transparency to be flattened (e.g., Illustrator 8.0 or Acrobat 4.0x-

compatible PDF 1.3).

If you do not want overprinting information used when you print a composite, select Ignore Overprinting

in Composite Output in the Illustrator Options panel of the Print dialog box. When you save documents in

earlier Illustrator formats or as Acrobat 4.0x-compatible files, the composite will include overprinting at-

tributes only in documents which contain transparency and need to be flattened—then the opaque repre-

sentation of the overprinting attributes will appear.

Saving Illustrator 9.0 artwork for use in other applications
Usually, your best option for using Illustrator 9.0 artwork in other applications is to save it as an Illustrator 9

EPS file. You can open an Illustrator 9 EPS file at any time to change the settings that affect how the artwork

appears in other applications and then resave the EPS file. Such settings include:

• the Quality/Speed slider in the Transparency panel of the Document Setup dialog box

• the Rasterization Resolution value in the Printing & Export panel of the Document Setup dialog box

• the Resolution value and other options in the Rasterize Effects Settings dialog box

Recommendations for using Illustrator 9.0 artwork in specific applications follow.

Page layout applications (e.g., Adobe InDesign 1.5, Adobe FrameMaker, Adobe PageMaker, and
QuarkXPress):
Save the artwork as an Illustrator 9 EPS file and place it into the application.

Adobe Acrobat 4.0x and Adobe Acrobat Distiller 4.0x
Save the file as an Illustrator 9.0 EPS and convert it to PDF 1.3 format using Acrobat Distiller.

Adobe GoLive™ 5

Place the native Illustrator 9.0 file.

Adobe LiveMotion™ 1.0
Save the file in Illustrator 8.0 format or as an EPS file, and then place the file into LiveMotion.

Adobe Premiere® 5.x and Adobe After Effects® 4.1

Save the file in Illustrator 8 format, and then place the file. Alternatively, you can copy the artwork from

Illustrator and paste it into Premiere or After Effects. When you copy and paste artwork that includes trans-

parency effects, make sure to select Preserve Appearance as the clipboard setting in the Illustrator Prefer-

ences dialog box. Note that transparent objects are flattened when you copy and paste them. (If Preserve

Paths is selected, you can paste the paths, but you'll lose the transparency.)

Microsoft® Office products
Save the file in EMF or WMF format and then insert it into the document.

See the Readme file for additional
information to consider when
you print or export artwork from
Illustrator 9.0.
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Glossary
Color stitching The visible transition between rasterized images and vector objects that are adjacent to

each other

Dots per inch (dpi) Often used interchangeably with ppi (see below), but when used accurately, it refers to a

printer’s resolution, not screen resolution.

Flattening  The process of dividing fully editable transparent objects into opaque, smaller, non-editable

vectors or rasters.

Line screen  Unit used to measure printed halftones. Dots from a printer combine to make lines per inch

(lpi), commonly referred to as a line screen.

Pixels per inch (ppi)  The number of horizontal pixels within one inch (also the number of vertical pixels in

one inch).

Rasterization  Conversion of vector objects to rasters (pixels), using resolution controls and masking to

maintain the highest quality output and resolution independence to the greatest extent possible.

Rasters  Also referred to as pixels. Small square units arranged in a grid formation to simulate imagery.

Vectors  Lines that define shapes based on a coordinate system.

Troubleshooting Index
This document provides information you need to ensure the highest quality output from Adobe Illustrator

9.0. Understanding the way Illustrator applies transparency and other features that affect printing and ex-

porting can help you avoid problems. To save you time, we've listed some of the issues addressed in the

paper and the pages on which you can find information about them

For help with this issue. . . refer to this page.
Blending modes don't look the same in Photoshop and Illutrator ......................................... 7-8

Color shifting on screen ................................................................................................................ 7

Color stitching .............................................................................................................................. 7

Composite includes unwanted overprinting information ...................................................... 8-9

Different plates print than expected ............................................................................................. 8

Document prints incorrectly with EPS involved in transparency ............................................... 6

Hairlines print thicker than expected ...................................................................................... 4-5

Illustrator 9 EPS file not transparent in page layout application ............................................ 7-8

Objects with effects print at low resolutions ................................................................................ 8

Unable to edit text (converted to outlines) .................................................................................. 5
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